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Framework

 This program will allow you to create an Atlas image as an average of
several registered DTl images. The registration will be done in two steps :
— Affine Registration with BRAINSFit
— Non-Linear Registration with GreedyAtlas

* A final step will compute the final Atlas by resampling and averaging the
registered images.

Affine Non Linear Final

DTI Atlas

N
DTI Images 4 Registration Registration Resampling
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Framework

Original DTls FA template
Affine Registration Pipeline !
Affine Registration Filter DTI |
The Affine Registration can “aﬁfi—_f_iffle_r_e_d? s E@
be done in several loops. L Soelm
At each |00p, the (<:case:>_craipe:mtr1.nrrd:. ;I::p
normalization and the Generate FA
registration will be done *“E‘E*&’A-“m’
with a new reference, to Normalization  |mcs y
improve the quality. The *ceser*_mmtﬂamm-nrrd
reference is the ﬁrSt case <cage> IoopN LinsarTrans FA.nrrde=| Affine Registration 'rEf
or a template you gave for <case> LoopN]LinearTrans.txt
the first loop, and then an l _ o
average computed at the Applytransiormations ¢
end of the |00p. <:ase}_lu::--:lpﬂ_lirfar'Irans_DT: .nrrd
[ Conerate FA of ] LoopH_FARvefage .nrrd
transformed DTls Compute the
P THE UNIVERSITY <casey LoopN_FA.nrrd iy t::::ieis
ﬂlTl of NORTH CAROLINA <case> Loopl FinalFA.nrrd
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Framework

AtlasBuilding Pipeline : Non Linear Registration

Non Linear Registration

v

MeanImage .mhd A

R <Case>_InverseH

Non Linear Registration
g =P <case> NonLinear

<case> HFjield.mhd

"ield.mhd

'rans

ref

Apply transformations <

<case> Di ffeomo*phicDTI .nrrd +FA

Average of Diffeomorphic DTls

DiffeorrprphicﬁtlasDTI.nrrdl + FA, MD, color FA, RD, AD

of NORTH CAROLINA
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Framework

* Final Resampling Pipeline

Final Resampling

First Resampling

<case> DeformedDTI

Average of final DTls Second Resampling

— medDTI . .nrrd +FA
<case> GlobalDisplacementField.nrrd

Final DTI Atlas
+ FA, MD, color FA, RD, AD
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Download
Online

e Source Code: GitHub: http://github.com/NIRALUser/DTIAtlasBuilder

— To get the source code from a linux shell:

$ git clone http://github.com/NIRALUser/DTIAtlasBuilder.git

$ git checkout v1.3

* Binary package: NITRC: http://www.nitrc.org/projects/dtiatlasbuilder
-> Downloads: Release v1.3

—_N THE UNIVERSITY
II | of NORTH CAROLINA
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http://github.com/NIRALUser/DTIAtlasBuilder
http://github.com/NIRALUser/DTIAtlasBuilder
http://www.nitrc.org/projects/dtiatlasbuilder

Download . :
Slicer Extension

e Slicer: http://www.slicer.org/

3DSlicer

=\ THE UNIVERSITY
II | of NORTH CAROLINA
1
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http://www.slicer.org/

Download

Slicer Extension

/\

b About

b The Main Window

1Y . -
¥ Data Probe

File Edit
A - X i
I E Python Interactor Ctrl+3 Lome Yo Slicer 2| == \ 1 ﬁ o % ﬁ » » -
 FExtension Manager  Ctrl+4 g A )
@ R 5:0,00 % 1
~ Module Panel Ctrl+5 |
{;\ Toclbars "
’ 4 Layol 4
Errar Log Ctrl+0
4- 4-
[ﬁ? Load DICOM Data [ﬁ? Load Data
i# Customize Slicer G Download Sample Data
=y T R: 0,00 (B9G SE T A 0,00

of NORTH CAROLINA

ﬁ THE UNIVERSITY e Open the Extension Manager in View ->
Il

vt CHAPEL HILL Extension Manager
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Download , ,
Slicer Extension

'7"‘_ Manage Extensions (0) é Install Extensions
* Click the blue INSTALL | ¢icer errencions
button under Categories
DTIAtlasBuilder =

= Tractography

= Examples

e The extension will be
downloaded and vyou xlnfomats
will need to restart
Slicer. insemreapiio

= Volume Rendering

e When restarted, you
will find the installed
extension in the
module list.
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Download

=

>

File Edit View Help

ga & &8 |Modules D

»

»

»

»

»

»

»

¥

Slicer

4 4
Welcole

.

-

E’:’n.? Load DICOM Data u
Es Customize Slicer 0

D

About

The Main Window

Loading and Saving

Display

Mouse & Keyboard

Documentation & Tutorials

Acknowledgment

Data Probe

Welcome to Slicer

Annotations

Data

DICOM

Editor

Models

Scene Views
Transforms

View Controllers
Volume Rendering
Volumes
Welcome to Slicer

on
Wizards
Informatics
Registration
Segmentation
Quantification
Diffusion

16T

Filtering
Surface Models
Converters
Endoscopy
Utilities
Developer Tools
Legacy

Testing

Work in Progress

Slicer Extension

ACPC Transform
Add Scalar Volumes
Affine Registration

~ Z Annotations

AtlasTests
BSpline Deformable Registration
BSpline to deformation field
@ Cameras
Cast Scalar Volume
ChangeTracker
Charting
CheckerBoard Filter
B Colors
Create a DICOM Series
& Crop Volume
Curvature Anisotropic Diffusion
Data
DataProbe
Demon Registration (BRAINS)
£ oicom
DICOM to NRRD Converter

Diffusion Tensor Scalar Measurements|

Diffusion Weighted Volume Masking

DTI At
DTI Atlas Fiber Analyzer

Builder

DTlexport

DTlimport

dtiprocess

DWI Joint Rician LMMSE Filter
DWI Rician LMMSE Filter

DWI to DTI Estimation

DWI to Full Brain Tractography

DWI Unbiased Non Local Means Filter

Editor
EMSegment Command-line

§ EMSegmenter with Atlas

& EMSegmenter without Atlas
Endoscopy
Event Broker
Execution Model Tour
Expert Automated Registration
Extract Skeleton
fiber_visibility_crash2438
FiberViewer Light
Fiducial Registration
Foreground masking (BRAINS)
Gaussian Blur Image Filter
General Registration (BRAINS)
Gradient Anisotropic Diffusion
Grayscale Fill Hole Image Filter

Grayscale Grind Peak Image Filter

Grayscale Model Maker
Histogram Matching
Image Label Combine

Intensity Difference Change Detection (FAST)

Label Map Smoothing

THE UNIVERSITY
of NORTH CAROLINA
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Label Statistics — — - - —
labelToggleBug2049
Linear Registration

Mask Scalar Volume
Median Image Filter
Merge Models
Model Maker
Model To Label Map

@ Models
Multiply Scalar Volumes i

MultiVolumeExplorer
Multivolumelmporter
NA4ITK MRI Bias correction

3€ OpenIGTLInkIF
Orient Scalar Volume
Otsu Threshold Image Filter
Otsu Threshold Segmentation
Performance Tests
PET Standard Uptake Value Cs
Probe Volume With Model

DTI Atlas Builder

mputation

Resample Scalar Volume
Resample Scalar/Vector/DWI Volume

Rigid Registration |
Robust Multiresolution Affine Registration
Robust Statistics Segmenter
RSNA2012ProstateDemo
RSNA2012Quant
RSNA2012Vis

B sample Data
Scene Import (Issue 2428)

R:0.00 SIGH A:0.00

Scene Views
Selffests
Simple Region Growing Segmentation

¥

SliceLinkLogic
SliceraMinute
slicerCloseCrashBug2590
Subtract Scalar Volumes
Threshold Scalar Volume
Tractography Display
Tractography Interactive Seeding
Tractography Label Map Seeding
Transform MRML Files to New EMSegmenter Standard
@ Transforms
Vector Demon Registration (BRAINS)
Vector to Scalar Volume
I View Controllers
ViewControllers Slice Interpolation Bug 1926
Volume Rendering

ee

Volumes
Voting Binary Hole Filling Image Fiter
WebGL Export

B\ Welcome to Slicer

You will now find the DTIAtlasBuilder just installe
in the list of all modules. Running the
DTIAtlasBuilder extension will open GUI that you

will use as if it was used by itself. .



GUI

» DTI Atlas Builder 1.3
File Help

Files | Affine Atlas | Diffesmorphic Atlas | Final Resampling | Software Configuration | Grid Processing |

1
[
Pod

Inputs
Select Cases :

ik

Save Data

[optional] [lee a template for the registration ] [

Output

| Browse Output Folder | |

|| Overwrite on compute

[ Stop ] I

Affine QC || Diffeomorphic QC || Final QC |

Clean Qutput Folder

—_N THE UNIVERSITY
II I of NORTH CAROLINA
i

S— at CHAPEL HILL
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sasicUse - add DT Images

DTI Atlas Builder 1.3

File Help

Files | Affine Atlas | Diffeomerphic Atlas | Final Resampling | Software Configuration | Grid Processing |

Inputs
Select Cases :

I

Add cases

[optional] | Give a template for the registration | | |

Qutput

[Browse Output Folderl [ l

Compute Owverwrite on compute Affine QC Diffeomorphic QC Final QC

Stop I 0% Clean Qutput Folder

- . _
THE UNIVERSITY * Clicking the '+' button will allow

=__\
” " of NORTH CAROLINA you to select several DTI images,
i

ULLIER at CHAPEL HILL and add it to the central Cases box
13



Basic Use
Remove DTl Images

File Help

Files | Affine Atlas ] Diffeomorphic Atlas ] Final Resampling ] Software Configuration ] Grid Processing ]

Inputs
Select Cases :

: /NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s01_QCed_VC_DTI.nrrd
: /NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s03_QCed_VC_DTI.nrrd
: [NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s04_QCed VC DTl.nrrd
: [NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s05_QCed VC DTl.nrrd
: INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking Vicki/DatasetSmocking/s06 QCed VC DTLnrrd
er/| i ] icki/DatasetSmocking/s07_QCed VC _DTl.nrrd

ck

/s08 QCed VC DTl.nrrd
Save Data

INIRAL/work/akaiser/DTIAtlasBuilder/DTI _Smaocking Vlckl!DatasetSmocklngfsll QCed WVC_ DTl.nrrd
11: /NIRAL/work/akaiser/DTIAtlasBuilder/OTI_Smocking_Vicki/DatasetSmocking/s12_QCed VC_DTl.nrrd

Remove selected cases

[optional] | Give a template for the registration | | ]

output

[Br—awse Output Folderl [ ]

Owverwrite on compute Affine QC Diffeomorphic QC Final QC

Stop I 0% Clean Qutput Folder

P N THE UNIVERSITY * After having selected some images,
of NORTH CAROLINA you can remove them from the central
t_!-— at CHAPEL HILL Cases box by clicking the '-' button

14



Basic Use ..
1 Give an output folder

DTI Atlas Builder 1.3

File Help

Files | Affine Atlas | Diffeomorphic Atlas | Final Resampling | Software Configuration | Grid Processing |

Inputs
Select Cases :

: INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s01_QCed_VC_DTI.nrrd
: INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s03_QCed VC DTl.nrrd
IMIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s04_QCed WC_DTl.nrrd :]
/NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s05_QCed _VC_DTl.nrrd
INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s06_QCed _VC_DTl.nrrd
INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s09_QCed _WVC_DTl.nrrd
: [NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s11_QCed VC_DTl.nrrd
: /NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smaocking_Vicki/DatasetSmaocking/s12_QCed_VC_DTl.nrrd

Bl

[optional] [Give a template for the registrationl [ ]

P
<’ | Browse Output Folder | [) ]

ompute Overwrite on compute Affine QC Diffeomorphic QC Final QC
Stop I 0% Clean Output Folder
P—_ % THE UNIVERSITY * You need to give an output folder: A folder named

"DTIAtlas" will be created in your output folder, and
all the files generated by the program will be put in it
(Data organization on slide 33)

of NORTH CAROLINA
$ at CHAPEL HILL
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Basic Use

Optional : Give a FA Template

* As an option, you can give a scalar image (FA) as a template that will be

used as reference for the affine registration with BRAINSFit in the first
loop.

* The values in this template image will be rescaled between 0 and 10 000
to avoid compatibility issues

* |If you do not give a template, the reference for the registration will be the
first case, and then the FA average if there are loops.

p—_N THE UNIVERSITY
II II of NORTH CAROLINA
é at CHAPEL HILL
16



Basic Use

Optional : Give a FA Template

DTI Atlas Builder 1.3

File Help

Files | Affine Atlas ] Diffeomorphic Atlas | Final Resampling ] Software Configuration ] Grid Processing ]

Inputs
Select Cases :

: INIRAL/work/akaiser/DTlAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s01_QCed_VC_DTl.nrrd
: INIRAL/work/akaiser/DTlAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s03_QCed_VC_DTl.nrrd
JNIRAL fwork/akaiser/DTIAtIasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s04_QCed_VC_DTl.nrrd
INIRALfwork/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s05_0QCed_VC_DTl.nrrd
/NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s06_QCed_VC_DTl.nrrd
JNIRAL fwork/akaiser/DTIAtIasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s09_QCed_VC_DTl.nrrd
: INIRAL/work/akaiser/DTlAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s11_QCed_VC_DTl.nrrd
: INIRAL/work/akaiser/DTlAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s12_QCed_VC_DTl.nrrd

Fen i

—

Load Data

/
< [optional] [Give a template for the registration] [ \

Use of a FA Template
tput

[Browse Output Folder] F’Tﬁmefﬁ\tlas

Owverwrite on compute

Affine QC ][ Diffeomorphic QC ][ Final QC ]

Stop I 0%
—_N THE UNIVERSITY
of NORTH CAROLINA
i at CHAPEL HILL
—
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Basic Use

Compute the Atlas

DTl Atlas Builder 1.3

File Help

Files | Affine Atlas ] Diffecrnorphic Atlas ] Final Resampling Software Configuration Grid Processing

Inputs
Select Cases :

: INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s01_QCed VT _DTl.nrrd
: INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s03_QCed_VC_DTl.nrrd

INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s04_QCed_VC_DTl.nrrd

INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s05_QCed_VC_DTI.nrrd
INIRAL/work/akaiser/DTIAtIasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s06_QCed_VC_DTl.nrrd
INIRAL/work/akaiser/DTlAtlasBuilder/DTI_Smocking Vicki/DatasetSmocking/s09_QCed V€ DTl.nrrd Load Data
: INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s11_QCed VC_DTl.nrrd
: [NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s12_QCed VC_DTl.nrrd Save Data

il

[optional] [Give a template for the registration] [!home}AtIas}FAtemplate.nrrd ]

Output

[Bmwse Output Fnlderl [fhnmefAtIas ]

e

</
Compute the Atlas

rwrite on compute Affine QC l [ Diffeororphic QC l [ Final QC ]

0% Clean Qutput Folder

—~— *  When you added cases and gave an output folder, you can
THE UNIVERSITY compute the Atlas by clicking the "Compute" button. It will
of NORTH CAROLINA test the existence and type of the files and the folders and

S at CHAPEL HILL tell you if some files are not images or DTls.
18



Basic U .
e Running Completed

| DTI Atlas Builder 1.3 E]@E]

File Help

Files | Affine Atlas Diffeomorphic Atlas | Final Resampling ] Software Configuration ] Grid Processing ]

Inputs

Select Cases :

Current C5V file : /NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DTIAtlas/DTIAtlasBuilderDataset.csv
1: /N ] ] ] icki i Ve DTL A n
2 " n " ik T g -
3: Running Completed ﬁ
4:
5: Running Completed !
s Q
T Final Atlas is in:
8: JNIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DTIAtlas/4_Final_Resampling/FinalaAtlasDTl.nrrd ata
9:

Final Displacement Fields for each case are in:
/NIRAL/work/akaiser/DTIAtIasBuilder/DTI_Smocking_Vicki/DTIAtlas/4_Final_Resampling/FinalDeformationFields/<case>_GlobalDisplacementField.nrrd

[optional] | Give a template for the registration | | |

Output

[Bmwse Output Folder] [!NIRAUwork!akaiser!DTIAtIasBuiIder!DTI_Smocking_Vicki ]

Overwrite on compute Affine QC ] [ Diffeomorphic QC ] [ Final QC ]

Running Completed

7 | THE UNIVERSITY *  This popup window will appear when the

of NORTH CAROLINA ing is d
i 2t CHAPEL HILL processing IS aone.

19



Options .
’ Overwriting

DTI Atlas Builder 1.3

File Help

Files | Affine Atlas ] Diffeomorphic Atlas ] Final Resampling ] Software Configuration ] Grid Processing

Inputs
Select Cases :

: INIRAL/work/akaiser/DTIAtlasBuilder/DTl_Smocking_Vicki/DatasetSmocking/s01_QCed _VC_DTl.nrrd
+ /NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smecking_Vicki/DatasetSmecking/s03_QCed_VC_DTL.nrrd
: INIRAL/work/akaiser/DTlAtlasBuilder/DTI_Smecking_Vicki/DatasetSmocking/s04_QCed VC_DTl.nrrd
: /NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smeocking_Vicki/DatasetSmocking/s05_QCed VC_DTLnrrd
: IMIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s06_QCed_VC_DTl.nrrd
: INIRAL/work/akaiser/DTIAtlasBuilder/DTl_Smocking_Vicki/DatasetSmocking/s09_0QCed _VC_DTl.nrrd
: /NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smecking_Vicki/DatasetSmecking/s11_QCed_VC_DTL.nrrd
: INIRAL/work/akaiser/DTlAtlasBuilder/DTI_Smecking_Vicki/DatasetSmocking/s12_QCed VC_DTl.nrrd Save Data

Load Data

CO =4 O LN L P e

B

[optional] [Give a template for the registration] [!home}AtIasfFAtemplate.nrrd ]

Qutput

| Browse Output Folder | | /home/Atias ]

| Overwrite on compute Affine QC || Diffeomorphic QC || Final C |
0% Clean Output Folder

Stop

n . n . .
P N THE UNIVERSITY * The "Overwrite" option will allow you

of NORTH CAROLINA write the images anyway, over existing
t_!-— at CHAPEL HILL images if they were computed already.

20



Options Affine Atlas

e Safety Margin : Add 2 slices at each side of the volume

e Initial Affine Transform :

If you put a transformation file named <case> InitLinearTrans.txt
or <case> InitLinearTrans.mat (<case> being the name of the
corresponding original DTl image without path and extension) in the folder
[OutputFolder]/DTIAtlas/1 Affine Registration/ as an affine
transform already computed, it will be used as an input to initialize the
affine registration with BRAINSFit

THE UNIVERSITY

II II of NORTH CAROLINA
é at CHAPEL HILL
21



Options Affine Atlas

DTI Atlas Builder 1.3

=

File Help

Files | Affine Atlas | Diffeomorphic Atlas | Final Resampling | Software Configuration | Grid Processing |

Add Safety Margin (2 slices on each side of the volume)
Affine Registration

Number of Loops for the Affine Registration : [ 1 |3/ (I 0 loops, no average will be computed)

Transform Mode : | useCenterOfHeadAlign % |

If you put a transformation file named CaseX_InitLinearTrans.mat or CaseX_InitLinearTrans.txt in the folder [Output Folder]/DTIAtlas/1_Affine_Registration/
as an Affine transform already computed, it will be used as an input for the Affine registration with BRAINSFIt for the case X

Overwrite on compute

Affine QC | | Diffeomorphic QC || Final QC
Stop I

0% Clean Output Folder

THE UNIVERSITY

of NORTH CAROLINA
at CHAPEL HILL
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options Diffeomorphic Atlas

* The Diffeomorphic Atlas is the Atlas computed from the affine registered
images to get the deformation fields from the affine space to the final
atlas space.

* These deformation fields will be applied to the original DTIs which will be
used to compute the first DTI average.

* You can choose the Scale Levels that you want for GreedyAtlas and also
the options for the resampling and for the average computation.

p—_N THE UNIVERSITY
II II of NORTH CAROLINA
é at CHAPEL HILL
23



Options

Diffeomorphic Atlas

DTl Atlas Builder 1.3

File Help

Files | Affine Atlas | Diffeomorphic Atlas | Final Resampling | Seftware Configuration | Grid Processing |

GreedyAtlas Scale Levels

v|Scale Level: [4 |2 Nb Of Iterations : | 150

V| Scale Level; Nb Of Iterations : | 120

¥|Scale Level: 1 [2{ Nb Of Iterations : | 100

Resampling Parameters

Gamma : [0.0100 |2 Max. Perturbation : [0.1000 |2

Resampling Interpolation Algorithm : [Linear =

3

Tensor Interpolation : [Log Euclidean =

Tensor Transformation : [Pra_qervation of the Principal Directien (PPD) ¥

Overwrite on compute Affine QC ] [ Diffeomorphic QC l [ Final QC
Stop | 0% Clean Output Folder

—

¢

THE UNIVERSITY
of NORTH CAROLINA
at CHAPEL HILL
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Options

Final Resampling

DTI Atlas Builder 1.3

File Help

Files | Affine Atlas | Diffeomorphic Atlas | Final Resampling | Software Configuration | Grid Processing |
DTI-Reg

DTI-Reg needs a program not used by DTIAtlasBuilder (ANTS). Please give a path to a folder containing ANTS if it is in a special place (not in the PATH), so DTI-Reg can find it:
| Browse Folder containing ANTS | |

Registration Method: IEBRAINS = ]

Registration Type: [ Diffeomorphic :]

Transform Mode: [Use computed affine transform % ]

Number Of Pyramid Levels: [ 5 }%‘

Number Of Iterations for the Pyramid Levels: [300'50'30'20'15 l

Overwrite on compute Affine QC ] [ Diffeornorphic QC l [ Final QC
Stop | 0% Clean Output Folder

— N THE UNIVERSITY * The Final Resampling will be done with DTI-Reg, it will
I | of NORTH CAROLINA create the global deformation fields from the original
i ot CHAPEL HILL space to the final atlas space. You can use either

BRAINS or ANTS, and you can also choose your options.



Options

"

DTI Atlas Builder 1.3
File Help

Files | Affine Atlas | Diffeomorphic Atlas | Final Resampling | Software Configuration | Grid Processing |

Final Resampling

DTI-Reg

DTI-Reg needs a program not used by DTIAtlasBuilder (ANTS). Please give a path to a folder containing ANTS if it is in a special place (not in the PATH), so DTI-Reg can find it:

| Browse Folder containing ANTS | |

Registration Method: | ANTS B
Registration Type: [GreedyDiffeo (SyN) S ]
Transformation Step: [0_25 ]
Iterations: [ 100x50%25 ]
Similarity Metric: | Cross-Correlation (CC) 3
Region Radius: [2_00

Gaussian Sigma: [100

Gaussian Smoothing Off

Overwrite on compute

Affine QC || Diffeomorphic QC || Final QC

Stop I 0%
—_N THE UNIVERSITY

of NORTH CAROLINA
é, at CHAPEL HILL
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Load and Save

Save your parameters: In the « File » Menu, you can Save or Load a parameter
file generated by the program. Do not change the parameter file manually,
because it could be recognized by the program as a corrupt file and not be read.

When you save the parameters, a .csv file with the dataset will automatically be
created in the same directory than the parameter file.

Auto save: When you push the « Compute » button, the program will
automatically save a parameter file (DTIAtlaSBullderParameters txt) and
a .CSV dataset file (DTIAtlasBuilderDataset.csv) in
[OutputFolder]/DTIAtlas.

It will also save a .csv file with the paths to all the interesting files generated, in
this same folder (DTIAtlasBuilderResults.csv).

You can save your Dataset into a CSV file so you can load it and use it again later.

You can also load a CSV file containing paths to a Dataset you saved before or
you wrote yourself with this format:  id,originat 011 nage

1, /home/Dataset/DTI_1.nrrd
2,/home/Dataset/DTI 2.nrrd
3,/home/Dataset/DTI 3.nrrd
4,/home/Dataset/DTI 4.nrrd
5,/home/Dataset/DTI 5.nrrd

THE UNIVERSITY 6, /home/Dataset/DTI 6.nrrd

. 7./home/Dataset/DTI 7.nrrd
Oj NORTH CAROLINA 8,/home/Dataset/DTI 8.nrrd
at CHAPEL HILL a, thIII'IE,"DEItEISEthTI .nrrd
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Load and Save

File Help

Files | Affine Atlas ] Diffeomorphic Atlas ] Final Resampling ] Software Configuration ] Grid Processing ]

Inputs
Select Cases :

1: /NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s01_QCed_VC_DTl.nrrd +

2: /NIRAL/work/akaiser/DTIAtlasBuilder/DTl_Smocking_Vicki/DatasetSmocking/s03_QCed VC _DTl.nrrd

3: /NIRAL /work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s04_QCed VC DTl.nrrd E

4: NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s05_QCed_VC_DTl.nrrd

5: /NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s06_QCed VC_DTl.nrrd

6: NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s09_QCed VC DTl.nrrd

7: /NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s11_QCed_VC_DTl.nrrd Open CSV file as Dataset
8: /NIRAL/work/akaiser/DTIAtlasBuilder/DTl_Smocking_Vicki/DatasetSmocking/s12_QCed VC DTl.nrrd i p

[optional] [Give a template for the registrationl [Ihome}AtIas}FAtempIateknrrd ]

Output

[Browse Output Folder] [!homemtlas| ]

Overwrite on compute Affine QC l [ Diffeomorphic QC ] [ Final QC l
Stop I 0% Clean Qutput Folder

—_N THE UNIVERSITY
of NORTH CAROLINA
é, at CHAPEL HILL
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Load and Save

File Help

Files | Affine Atlas | Diffeomorphic Atlas | Final Resampling | Software Configuration | Grid Processing |

Inputs
Select Cases :

1 [NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s04_QCed VC DTl.nrrd
: INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s05_QCed_VC_DTl.nrrd
1 INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s06_QCed_VC_DTL.nrrd
: /NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking Vicki/DatasetSmocking/s09_QCed VC_DTl.nrrd
: INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s11_QCed_VC_DTl.nrrd
: /INIRAL/work/akaiser/DTIAtlasBuilder/DTl_Smocking_Vicki/DatasetSmocking/s12_QCed VC_DTIl.nrrd

: INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s01_QCed_VC_DTl.nrrd
: /INIRAL/work/akaiser/DTIAtlasBuilder/DTl_Smocking_Vicki/DatasetSmocking/s03_QCed _VC_DTIl.nrrd

|Generate a CSV file with Dataset

[optional] [Give a template for the registration ] [,.fhome;AtIas..fFAtempIate.nrrd ]

output

[Brnwse Qutput Folder] [!home}htlaq ]

Overwrite on compute Affine QC ] [ Diffeomorphic QC ] [ Final QC ]
Stop I 0% Clean Qutput Folder

—_N THE UNIVERSITY
of NORTH CAROLINA
$ at CHAPEL HILL
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Keyboard Shortcuts

* RETURN or ENTER: Compute
e PLUS: Add cases
* MINUS or DELETE: Remove cases

* |t is also possible to drag and drop any file (DTl image, dataset CSV file,
software configuration file or parameter file) into the window to be loaded.

p—_N THE UNIVERSITY
II II of NORTH CAROLINA
é at CHAPEL HILL
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Quality Contro

DTI Atlas Builder 1.3

File Help

Files | Affine Atlas | Diffeomorphic Atlas | Final Resampling | Software Configuration ] Grid Processing

Inputs
Select Cases :

: /NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s01_QCed_VC_DTl.nrrd
/NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s03_QCed_VC_DTl.nrrd
INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s04_QCed_VC_DTl.nrrd
INIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s05_QCed_VC_DTl.nrrd
/NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s06_QCed_VC_DTl.nrrd
/NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s09_QCed_VC_DTl.nrrd
: /NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s11_QCed VC_DTl.nrrd
/NIRAL/work/akaiser/DTIAtlasBuilder/DTI_Smocking_Vicki/DatasetSmocking/s12_QCed_VC DTl.nrrd Save Data

Load Data

@ W

Bl |

[optional] [Give a template for the registrationl [;home}AtIas}FAtemplate.nrrd l

Output

[Bmwse Output Falder] [}homemtlaq l

S ——
Affine QC ][ Diffeomorphic QC ][ Final QC ]‘)
C with MriWatcher

Overwrite on compute

Stop 0 0%

* By pushing one of the QC buttons, you will
run MriWatcher to see the images at
different steps of the compute, and check
if the results are good. 31

THE UNIVERSITY
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Quality Control

Final QC:

Slice View

Final DTI-Reg resampled o e 0 vy 0 2vew || B vt e (] |
FAs and final Atlas View Options | “oroving Options %
® View All Image

THE UNIVERSITY
of NORTH CAROLINA

) View Imagesi|3 | Columns

[J Image Infos [ Pixel Intensity

. Overlay Scale

- Visualiztion Options

Intensity Min: e

MriWatcher 2.2

i w— ) | i — R S
— . [] Slice Blending - Right mouse: Zoom
= M ‘
) G @ @ § Alpha: — Middle mouse: Sele

- Shift + mouse: Glol

* Affine QC: L _,:_,
Affine registered FAs
and last affine average
computed
« Deformable QC: T
Deformably registered
FAs and Diffeomorphic
Atlas |

Ll

= 5 at CHAPEL HILL
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Software Configuration
Manual Configuration

DTI Atlas Builder 1.3

File Help
...
Files morphic Atlas ] Final Resampling Software Configuration Grid Processing ] —
L~ B
(\ | ImageMath || [ D ®r |
"
e — — [ & |
[ CropDTI || i R |
[ dtiprocess || I R |
[ BRAINSFit || I r ]
[ GreedyAtlas Il I r ]
[ dtiaverage || I R |
[ omee [ ——
[ ww [
[ MriWatcher || I r ]
You can set an environment variable manually with the name "DTIAtlasBuilderSoftPath" and contaning the path to a configuration file.
It will be read at the beginning of the program.
$ setenv DTIAtlasBuilderSoftPath [your config file]
Number of Threads to use: If 0, no option will be given so the programs will use their default behavior

Overwrite on compute Affine QC || Diffeomorphic QC || Final QC
Stop I 0% Clean Qutput Folder

P N THE UNIVERSITY e If you have your oyvn versnorf of thg programs or. if you
” " of NORTH CAROLINA need to use a particular version of it, you can write the
Al at CHAPEL HILL path manually or click the button to search it.
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Software Configuration
Automatic Configuration

LT Atlas Builder 1 e
File Help
Files | Affine Atlas | Diffeomorphic Atlas | Final Resampling | Software Configuration | Grid Processing |
[ mogevan | [ ——
| ResampleDTllogEuclidean | | I R
[ cwon | [——
| [
[ BRAINSFit || I R
[ GreedyAtlas || I R
[ dtiaverage || I R
[ onmes [
T [
[ MriWatcher || _— Il rR ]
R AR R E R s 'Dm@“ R t“e@
$ setenv DTIAtlasBuilderScftPath [your config file]
Number of Threads to use: If 0, no option will be given so the programs will use their default behavior

Overwrite on compute Affine QC l [ Diffeomorphic QC l [ Final QC
Stop | 0% Clean Output Folder

of NORTH CAROLINA automatically search all the programs in the
— at CHAPEL HILL

/:_\,I THE UNIVERSITY * By clicking the "Default" button, the program will
||

PATH, and tell you if some of them are missing.



Software Configuration

- Automatic Configuration

DTI Atlas Builder 1.3

File Help
Files | Affine Atlas | Diffeomorphic Atlas | Final Resampling | Software Configuration | Grid Processing | |
( ImageMath || /tools/bin_linux64/imageMath ‘/ﬁ R w
| ResampleDTllogEuclidean | | /tools/bin_linux64/ResampleDTllog Euclidean \L[_‘ il
[ CropDTI || /toolsfbin_linux64/CropDTI ] [\T—[
[ dtiprocess | | toolsfbin_linux64dtiprocess i R |
[ BRAINSFit || froolsfbin_linux64/BRAINSFit I r ]
( GreedyAtlas || ftoolsfbin_linux64/GreedyAtlas IR ]
[ dtiaverage ] [ftoolsfbin_Iinux64!dtiaverage ] [ R ]
[ DTI-Reg | | toolsfbin_linux64/DTI-Reg_1.1.2 IR ]
[ unu || ftoolsfbin_linux64/unu i R ]
[ Mriwatcher | | ftoolsfbin_linux64/Mriwatcher I r

It will b

Default

e read at the beginning of the program.

§ setenv DTIAtlasBuilderSoftPath [your config file]

Number of Threads to use: If 0, no option will be given so the programs will use their default behavior

You can set an environment variable manually with the name "DTIAtlasBuilderSoftPath” and contaning the path to a configuration file.

Overwrite on compute

Stop I

Affine QC || Diffeomorphic QC || Final QC

0%

Clean Qutput Folder

Il

¢

THE UNIVERSITY
of NORTH CAROLINA
at CHAPEL HILL

* If you want to reset the path for one or more
programs, just push the "R" button and it will
search the corresponding program in the PATH.
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Software Configuration

Ll

S ——

Load and Save

Save your configuration: In the « File » Menu, you can Save or Load a
configuration file generated by the program.

You can set an environment variable manually with the name
“DTIAtlasBuilderSoftPath” and contaning the path to a configuration
file. It will be read at the beginning of the program to configure the
softwares.

When opening the program, it will automatically search and load any file
called “DTIAtlasBuilderSoftConfig.txt” in the directory where the
executable is and in the current work directory.

So you can put this file in any of these folders and you will not have to set
an environment variable to have to software automatically configured.

THE UNIVERSITY
of NORTH CAROLINA

at CHAPEL HILL
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Command Line

Command Line Options

« DTTAtlasBuilder —--help»:
* Load:

-d <std::string>, --dataset file <std::string>:
CSV file containing the dataset
-p <std::string>, --parameter file <std::string> :

Parameter file from this program

-c <std::string>, --configuration file <std::string>:

Software configuration file

* Options:

Ll

S ——

--overwrite: If you want to overwrite on compute (default: 0)
--nogui : If you do not need the GUI (default: 0)

THE UNIVERSITY
of NORTH CAROLINA
at CHAPEL HILL
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Command Line

No GUI mode

* In « No GUI » mode, you need to set the parameters by giving a parameter
file in command line :

DTIAtlasBuilder --nogui -p /home/DTIParameters.txt

* The program will not display the GUI and will run automatically with the
given parameters, as if you had pushed the « Compute » button.

THE UNIVERSITY

II II of NORTH CAROLINA
i at CHAPEL HILL
—
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Grid Processing

File Help

Files | Affine Atlas | Diffeomorphic Atlas | Final Resampling | Software Configuration | Grid Processing |

+| Enable Grid Processing

If using grid processing, the number of threads used will be automatically set to 1
Please give the command to use to run a command on server :

"basub mkdir NewFolder" -> Write "bsub"
submit

Before running DTI Atlas Builder on the grid, please be sure to have all tools listed in the "Software Configuration” tab installed on the grid with their
paths configured.

Overwrite on compute Affine QC l [ Diffeormorphic QC l [ Final QC
Stop 0% Clean Output Folder

* If you have the possibility of using a grid processing, you
can run DTI Atlas Builder on this grid by checking the
corresponding box and providing the submit command for
your grid. For each step of the pipeline, the commands for
all the cases will be submitted at the same time, and the
program will wait until all cases have been processed. ,

THE UNIVERSITY

of NORTH CAROLINA
at CHAPEL HILL
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External Requirements

« As DTIAtlasBuilder uses some external tools that you may not have installed on your
machine, you have the possibility to compile all tools you don’t have in the same time than
DTIAtlasBuilder

« The CMake cache contains an option « COMPILE_PACKAGE » that will allow you to choose
which tool you want to recompile.

 The external programs needed are:

ImageMath GreedyAtlas
ResampleDTllogEuclidean  dtiaverage
CropDTI DTI-Reg
dtiprocess MriWatcher
BRAINSFit unu

* You can also download the whole executable package, to have DTIAtlasBuilder and the
other tools already compiled, ready to use:

http://www.nitrc.org/projects/dtiatlasbuilder

p—_N THE UNIVERSITY
II II of NORTH CAROLINA
$ at CHAPEL HILL
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http://www.nitrc.org/projects/dtiatlasbuilder
http://www.nitrc.org/projects/dtiatlasbuilder
http://www.nitrc.org/projects/dtiatlasbuilder
http://www.nitrc.org/projects/dtiatlasbuilder
http://www.nitrc.org/projects/dtiatlasbuilder
http://www.nitrc.org/projects/dtiatlasbuilder
http://www.nitrc.org/projects/dtiatlasbuilder

Data Organization

™ ™ ™

Dataset Parameters Results
.CSV Axt .CSV

THE UNIVERSITY
" I of NORTH CAROLINA
1

— at CHAPEL HILL
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Data Organization

* « 1 Affine_Registration » contains:

« 3_Diffeomorphic_Atlas » contains:

— LoopN: . .
P — <case>_DiffeomorphicDTl.nrrd + float & FA
* <case>_LoopN_FA.nrrd
* <case>_LoopN_LinearTrans.txt — DiffeomorphicAtlasDTl.nrrd
* <case>_LoopN_LinearTrans_DTl.nrrd + float. FA. Color FA. MD. RD. AD

* <case>_LoopN_LinearTrans_FA.nrrd
* <case>_LoopN_NormFA.nrrd
* LoopN_FAAverage.nrrd

— <case> filteredDTl.nrrd
— <case> FA.nrrd
— (<case>_croppedDTl.nrrd)

* « 2_NonlLinear_Registration » contains:
— GreedyAtlasParameters.xml

« 4_Final_Resampling » contains:
— Fisrt & Second_Resampling temp folders
— FinalTensors:
<case>_FinalDeformedDTl.nrrd + float & FA

— FinalDeformationFields:
<case>_GlobalDisplacementField.nrrd

— FinalAtlasDTl.nrrd

— Meanimage.mhd + float, FA, Color FA, MD, RD, AD
— <case>_ HField.mhd

— <case>_InverseHField.mhd * « Script » contains:

— <case> NonlLinearTrans FAmhd — DTIAt|asBui|der_|V|ainScript.SCI‘ipt
- - — DTIAtlasBuilder_Preprocess.script
=\ THE UNIVERSITY — DTIAtlasBuilder_AtlasBuilding.script
II II of NORTH CAROLINA
$ at CHAPEL HILL
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Troubleshooting

 Final Atlas is bad

— Ifyou see in the QC windows that the Affine and Diffeomorphic Atlases and registered images
look OK, and that the Final Atlas and images look bad for all or most cases, that means that
something went wrong during the FINAL registration.

If this final registration was done using BRAINS, try to recompute it using ANTS (in the Final
Resampling tab > Registration Method), which gives a better registration.

* Loading parameter file fail
— If a parameter file fails to open in DTIAtlasBuilder (Parameter file is corrupted), you need to
recreate it by loading only the corresponding dataset file and setting your options again.
* QCdoes not show up

— If the QC windows do not appear when pushing the QC buttons, it might mean that you need to
install the GLUT library to get MriWatcher to work.
You can find the GLUT library here:
http://www.opengl.org/resources/libraries/glut/glut_downloads.php

=N THE UNIVERSITY
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Contact

For any remark or question, please email:

akaiser@unc.edu
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